™

reCAPTCHA

I'm not robot



https://irlanc.ru/uplcv?utm_term=shortcut+keys+of+ms+word+2013+pdf

Shortcut keys of ms word 2013 pdf

Shortcut keys of ms word 2013 pdf. All shortcut keys of ms word 2013 pdf.

12 June 2013 from Gul Microsoft Word offers many keyboard shortcuts to speed up the document. In Word 2013 it is equipped with two separate groups of shortcut keys: a set reflects the names of the control buttons on the belt, while the other set also used by previous versions of Word extends over multiple commands and is customizable. 1. Press
and release the ALT button for the display button instructions. Keytips are letters and numbers representing the ribbon and buttons on the quick access bar. Press the letter for the card you want, and more the key indications appear for the commands that card. 2. Press the letter or letters for the command you want. Shortcut keys: Open a Ctrl +
document or save a document Ctrl + s Close a document But leave Word running Ctrl + W Ctrl + C selection Cut the selection Ctrl + X paste the contents of the Ctrl + V clipboard Show or Hiding the CTRL + F1 multi-function bar Apply bold direct formatting CTRL + B Apply italer Direct formatting CTRL + I Apply single underline direct formatting
CTRL + U Left-align a paragraph Ctrl + L Center-Align a Ctrl + paragraph and the right button of the align a paragraph ctrl + r cancels the latest command ctrl + z restore the last command ctrl + y apply the normal style ctrl + shift + n print the document ctrl + p Open the f1 guide box if a command often uses doesn t have A built-in keyboard
shortcut, or if you give t as the shortcut key that is assigned to the command, you can create one both in a specific document or or in a model. 3. Display the Personalize Dialog Multi-function dialog box dialog box. 4. Under Choose Panel Commands, to the right of shortcut keys, click the Customize button. 5. In the Customize dialog box, select the
category that contains the command for which you want to create a keyboard shortcut, and then select the command. Current dialog boxes Displays any combination of keys already assigned to the command. 6.To Save the keyboard shortcut only in the current document, click the document name in save changes in the list, and then click Assign. 7. To
delete all custom keyboard shortcuts, click Restore All. 8. Close the Customize dialog box and the Word 2013 window, Word Options dialog box makes it much easier to insert videos, images and graphics from the Internet in the documents he used to be. Instead of having to find these materials in the browser, download them on the PC and then head
towards Word to insert them, you can do all this in Word, downloading them directly into your document. I do it, first go to the Insert tab. Then choose online or online videos, depending on whom you want to enter. If you choose to insert images, you arrive at a screen that allows you to search for the Clip Art Office.com collection, use Bing Image
search or browse the oneDrive.You can also insert images from Facebook and Flickr, the time that before connecting the Your Account Office to them. To connect to one, click the icon for the service at the bottom of the screen, insert images and follow the instructions. Once this is done, you will be able to navigate them and a graphic insert from
them in your import documents.No what way you get to the graphics, when you find what you want to enter, click on it and select Insert, the image comes Downloaded directly into the document. Once there, you can change it just as you would with any other graphics, including the use of alignment guides.similarly, when choosing to insert a video,
you have a choice of Bing video for a video, or youtube search and insertion from there. If you know the exact code for the incorporation of a video (many video sites will allow you to copy the code), you can use it as a well.unlike with graphics, you will actually not actually download the entire video. On the contrary, the opening video screen appears
with a series of controls. Click the arrow to play the video and play directly from Word, streaming from the Internet. Look how to insert photos and videos and modify them with built-in words tools. Manage Accountshead to the file file and you will notice a new menu item at the bottom left: Account. This menu allows you to manage your subscription
Office and the account, Windows 8 account, your account onedrive and links with other services, such as Facebook and Twitter.What you can change on this screen may vary depending on how your life is deeply rooted in the Microsoft ecosystem. If you have Windows 8 and use a Microsoft account, the information for the user on the left will be
possible to change your account picture from Microsoft and "About me" information, and allows you to switch to another that account.Underneath , you can select the global settings and not just for Word, but for all of Office, including a background and theme. And then under that, you can edit all of the services you have connected to your Microsoft
account, such as Facebook, Twitter, LinkedIn and onedrive. Only the services you have connected to your Microsoft account will reveal here.When you click the Manage button next to one of the accounts, such as Twitter, you submit to the Web browser, where you can see and manage what information is shared between Microsoft account and that
account. The options depend on the service. For Twitter, for example, you can remove the link between Microsoft and Twitter accounts; Configure whether to view contacts and their tweets from Twitter Windows 8, Windows Phone and Outlook.com; and share photos and documents from Office, onedrive, Windows 8 and Windows Phone with your
Twitter contacts.If you have a subscription to Office, on the right side of the Account screen you will be able to see information on the version of Office and manage it. You'll be sent to the Web and see all the machines on which you installed Office, how many installations you left, and so on. You can even installations off from in there as well.IDG The
new Account menu on the File tab lets you manage the Office subscription and your account, your account onedrive, and connections to other services, such as Facebook and Twitter. (Click image to enlarge.) Most functions of Word 2013 to learn aboutThere are other changes you'll find in Word 2013. Here are the most important ones.Alignment
guidesIf you use Word to create documents with images in them, you welcome Word 2013 alignment guides. They help you picture your alignment, graphics, shapes and graphics with the text in the document. They appear when you need it - place the object where you want it, click on the object and then click on the icon to its small right.When you
do, a menu appears that lets you choose different layouts for how you want the object to work with text - for example, you may have the casing of the text around it, to have the text displayed above and below it, or even have the text appears in front of it. To change the alignment again after you've changed already, simply click the object again and
use the alignment guides to choose the alignment you want.IDG New in Word 2013 are alignment guides, who make easier to place photos, graphics and tables exactly where you want them. (Click image to enlarge.) Work with PDFsPDFs and Word have long been at odds - in previous versions of Word could not read or edit a PDF document. In Word
2013, which has changed. You can now choose File -> Open and select a PDF file to open it.When you open a PDF, Word 2013 converts .docx Word documents. It does its best to retain the formatting, graphics, and so on. He does a good job in general, although I discovered that the graphics-heavy documents sometimes have problems. I also found
that sometimes puts Word breaks odd line in the middle of sentences. So if you A PDF file to edit, control carefully.You can edit the file as you would with any other .docx file, including the use of comments and the detection of the changes. It is therefore possible to save in any of the usual 2013 Word formats, including as PDF.IDG using this menu,
you can easily change how tape behaves. Easier controlhow tape Most of the tape is To see how you work? Do you like going away? Do you want to view only the cards? Or do you prefer nine yards - cards with commands below them Word 2013 makes it easy to choose one? On the top right of the screen, click on the icon of a rectangular window with
an arrow on it, and a menu drops that allows you to choose between the three viewmarks views.Automatic to help your new memory function in Word 2013 can finish to save a considerable amount of time. When you stop writing, editing or reading a document, a bookmark is in the last place to scroll. So the next time the document opens, you will be
wondered if you want to go to the point where it was interrupted. If you synchronized the document from Microsoft OneDrive, when you open the next document from Microsoft OneDrive or another device, you can go to that same bookmark spot.online presentationword 2013 gets a sharing tool that was introduced in PowerPoint 2010, but It was not
available in Word 2010. You can now share an online Word document with anyone with Internet access, even if they don't use Word. Send a link and start the presentation, and will be able to see the document in your browser as it flows through it. It's just a presentation, even if - they can't change or interact with the document. And once the
presentation is interrupted, they will be more able to see the document. You use the function, click the File tab and select Share -> present online. A screen is displayed with a URL that you send to others. Click Send to Mail to launch your e-mail client with the link already in it, or click Copy Link and then paste it into any method that will be used to
send the URL.IDG to share a Word document document Line, send people a bond, then start the presentation. (Click on the image to enlarge it.) Once the recipients went to URL, scroll through the document, and they will see the document exactly as you are seeing. When you want to stop the online presentation, click the "Fine presentation online"
button. That ends the presentation and disconnect viewers from shortcut keys for word it.handy 2013as in previous versions of Word, you can press the Alt key to view the keyboard shortcuts for navigating the ribbon cards. For example, ALT-H takes you to the Home tab, and ALT-G leads to the Design tab. (To find the specific commands on the
ribbon, see our quick reference tape.) IDG with the ALT key helps to master the ribbon. (Click on the image to enlarge). But there are many other keyboard rapid choices that allow you to create a wide range of activities in Word 2013. We have listed those we found the most useful below. For even more shortcut keys, see the Microsoft Office website.
Combination of action keys Navigation document CTRL-arrow Move to a paragraph Ctrl-arrow downwards Move down a paragraph Ctrl-right arrow Move to the right of a word Ctrl-left arrow Move to the left of a word Ctrl-home Move to the top of the CTRL-END DOCUMENT Move at the end of the document Ctrl-G or F5 Go to a page, bookmark,
note, table, comment or some other Alt-Ctrl-Z switch position between the last four seats in the document has been modified Alt navigation tape -F Go to the Alt-H file tab Go to the Home Tab Alt-N Go to the Insert Alt-G tab Go to the Alt-]JT Design tab Go to Table Design Table Table Alt-P Go page Layout Alt-JL tab Go to the tools Alt-s card layout table
Go to card ALT-M Go to the Alt-R letters tab Go to the review Alt-W card Go to card View text Formatting Ctrl-B Making text in bold CTRL-I text Make text in italics Ctrl-U underlined CTRL-SHIFT-D Double text CTRL-SHIFT-W underlines underlined a word CTRL-SHIFT-A make text All text caps make small cap CTRL-SHIFT-K CTRL-SHIFT + CTRL
Make the text in apex = Make the text Pedice Ctrl + Shift +> Make bigger characters CTRL-SHIFT-
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